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Migrating Your IT Charge Manager 
Environment from SAS Version 6 to SAS 
Version 8
Introduction
You do not need to read this document if you are installing IT Charge Manager for the first time.

This document explains how to migrate your IT Charge Manager Release 2.0 (ITCM 2.0) that is 
currently running under SAS Version 6 to IT Charge Manager Release 2.3 (ITCM 2.3) running under 
SAS Version 8.  Please read through the instructions before acting on them, because the choices may 
make a difference at your site.

Preparation
1. IMPORTANT! Make backup copies of your SAS Version 6 PDBs that you want to migrate. 
2. Verify that the release level of IT Service Vision (ITSV) on the server host is compatible with 

SAS Version 8 ITCM 2.3.  The release level of your ITSV should be 2.3 or later.  The release 
level of the SAS software that your ITSV is installed on should be 8.1 or later.  

3. Complete the migration of your ITSV environment from SAS Version 6 to SAS Version 8 by 
following the instructions in the document "Migrating Your IT Service Vision Environment 
from SAS Version 6 to SAS Version 8."  You should have the Version 6 ITSV PDBs 
successfully converted to Version 8 ITSV PDBs prior to migrating your ITCM environment. 

4. IMPORTANT! Make backup copies of the Version 8 ITSV PDBs. 
5. Make a backup copy of your ITCM 2.0 site definitions.  Whenever you invoke ITCM 2.0, you 

are greeted by the Welcome to IT Charge Manager window.  The Welcome window displays 
the Site Definition that you have defined.  You will find the data set storing the site definition 
at your ITCM 2.0 installation path, 
drive:\[SAS Version 6 Install Path]\addon\cpe\chm\ec\ecsite\ec_sites.sd2.

To make a backup copy of this data set, use either the MS-DOS command or Windows 
Explorer to copy the ec_sites data set to a new location. 

For example, if c:\sas6\addon\cpe\chm\ec\ecsite\ec_sites.sd2 is the site 
definition data set for ITCM 2.0, the MS-DOS command for making a backup copy in a 
new location, c:\backup, is

COPY c:\sas6\addon\cpe\chm\ec\ecsite\ec_sites.sd2 c:\backup

You will need to replace the default site definitions data set provided by ITCM 2.3 with 
this backup data set.  A later section in this document will explain the process of 
recovering your site definitions in ITCM 2.3.

6. Install ITCM 2.3 on SAS Version 8 and the most recent maintenance package of ITCM 2.3 
according to the Installation Guide for IT Charge Manager Software for Windows. 
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Your SASUSER Library
The first time you use ITCM 2.3, it will create a default SASUSER library. However, you might have 
information in your ITCM 2.0 SASUSER library that you want to continue to use for ITCM 2.3.  
Following are the instructions to copy the contents of the ITCM 2.0 SASUSER library to the ITCM 
2.3 library.  

1. Determine the location of your ITCM 2.0 SASUSER library by invoking ITCM 2.0 and 
selecting Globals from the pull-down menu.  Click Program Editor and type the following 
statements in the Program Editor window: 

OPTIONS SOURCE NOTES;

LIBNAME SASUSER LIST;

PROC DATASETS DD=SASUSER;

RUN;

2. Select the Locals pull-down menu and click Submit. 
3. Select the Globals pull-down menu and click Log.  You should see statements similar to those 

below.  Your SASUSER library is identified by the label Physical Name.  In this example, the 
location of the SASUSER library is d:\SAS6\Addon\cpe\chm\ec\sasuser. 

2 LIBNAME SASUSER LIST;
NOTE: Libref= SASUSER
Engine= V612
Filefmt= 607

Physical Name= d:\SAS6\Addon\cpe\chm\ec\sasuser

3 PROC DATASETS DD=SASUSER;

-----Directory-----

Libref: SASUSER
Engine: V612
Physical Name: d:\SAS6\Addon\cpe\chm\ec\sasuser

# Name Memtype Indexes
-----------------------------------------------------

1 EIS CATALOG
2 MBUSER DATA YES
3 PARMS CATALOG
4 PROFILE CATALOG
5 PROFILE2 CATALOG
6 SASMBC DATA YES
7 SASMBI DATA

4 RUN;
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4. Record the physical name of your Version 6 SASUSER library.  Exit ITCM 2.0 by selecting 
Exit IT Charge Manager and SAS.   

5. Invoke IT Charge Manager Release 2.3 for SAS Version 8.  In the Welcome to IT Charge 
Manager window, click Exit and select Exit IT Charge Manager Only. 

6. Select View from the pull-down menu and click Program Editor.  Maximize the Program 
Editor window and type the statements shown in Step 1. 

7. Select the Run pull-down menu and click Submit. 
8. Select the View pull-down menu and click Log.  Maximize the Log window.  You should see 

the location of the ITCM 2.3 SASUSER library indicated by Physical Name.  Record the 
physical name of your Version 8 SASUSER library. 

9. Select the File pull-down menu and click Exit to exit ITCM 2.3.  Now you are ready to 
proceed with the conversion of the SASUSER library.  

10. Invoke SAS Version 8 for Windows outside of ITCM 2.3. 

Note: Do not invoke SAS Version 8 by launching ITCM 2.3.  Although the option exists 
to exit ITCM only and stay in SAS, if you do this the SASUSER library will be locked 
and cannot be modified.

11. In the Program Editor, type the following code, edit the location of your SASUSER libraries, 
and submit the edited code. 

LIBNAME olduser 'location-of-your-ITCM 2.0-SASUSER-library' ACCESS=READONLY;

LIBNAME newuser 'location-of-your-ITCM 2.3-SASUSER-library';

PROC COPY IN=olduser OUT=newuser;

RUN;

12. Select Log from the View pull-down menu.  You should see notes indicating that the contents 
of the old SASUSER have been successfully copied to the new SASUSER library. 

13. Select Exit from the File pull-down menu and exit SAS Version 8. 

Your Site Libraries for IT Charge Manager
Following are the instructions for copying the contents of the ITCM 2.0 site libraries to the ITCM 2.3 
site libraries.

1. Find the location of your ITCM 2.0 site libraries.  You can determine the location of these 
libraries by invoking ITCM 2.0 and selecting a site in the list box "Select Site to Administrator 
or Define."  You should see the IT Charge Manager Site Prefix in the Site Properties box 
below.   

� On an OS/390 server host: 

If your ITCM 2.0 site prefix is OLDSITE, you should find the site libraries 
as follows:

� OLDSITE.EC.AUTO 
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� OLDSITE.EC.DATA 
� OLDSITE.EC.LIB 
� OLDSITE.EC.SCNTL 
� OLDSITE.EC.SITE 

� On an NT server host: 

If your ITCM 2.0 site prefix is c:\oldsite, you should find the site 
libraries as follows:

� c:\oldsite\ec

� c:\oldsite\ec\auto

� c:\oldsite\ec\data

� c:\oldsite\ec\lib

� c:\oldsite\ec\scntl

� c:\oldsite\ec\site 

2. Decide what you want your ITCM 2.3 site prefix to be. 
3. Allocate space for storing the ITCM 2.3 site libraries. 

� On an OS/390 server host: 

Run IEFBR14 or use ISPF 3.2 to allocate space for the ITCM 2.3 site 
libraries.  You will need to allocate the libraries as shown below for each 
site.  For allocation you can use the same DCB= as the one for the ITCM 2.0 
library.  If your ITCM 2.3 site prefix is NEWSITE, allocate space for  

� NEWSITE.EC.AUTO 
� NEWSITE.EC.DATA 
� NEWSITE.EC.LIB 
� NEWSITE.EC.SCNTL 
� NEWSITE.EC.SITE 

� On an NT server host: 

If your ITCM 2.3 site prefix is c:\newsite, create the following directories:

� c:\newsite\ec

� c:\newsite\ec\auto

� c:\newsite\ec\data

� c:\newsite\ec\lib

� c:\newsite\ec\scntl

� c:\newsite\ec\site 

4. Copy the contents of the ITCM 2.0 site libraries to the ITCM 2.3 site libraries. 

� On an OS/390 server host: 

a. Start with OLDSITE.EC.DATA and OLDSITE.EC.SITE.  These two 
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libraries contain SAS objects such as catalogs, data sets, and views.  
The SAS COPY procedure is used to convert the SAS objects from 
Version 6 to Version 8. 

Invoke SAS Version 8 on the server host and type the following 
statements in the Program Editor window.  Edit the location of 
your ITCM site library and submit the edited code for the two 
libraries, respectively.

LIBNAME oldlib 'location-of-your-ITCM 2.0-site-library'

DISP=SHR;

LIBNAME newlib 'location-of-your-ITCM 2.3-site-library';

PROC COPY IN=oldlib OUT=newlib;

RUN;

For example, if OLDSITE.EC.SITE is your ITCM site library, 
the edited statements should be

LIBNAME oldlib 'OLDSITE.EC.SITE' DISP=SHR;

LIBNAME newlib 'NEWSITE.EC.SITE';

PROC COPY IN=oldlib OUT=newlib;

RUN;

If you check the ITCM 2.3 site libraries at this point, you should 
see SAS Version 8 objects such as catalogs, data sets, and views 
that have been converted from the corresponding SAS Version 
6 objects in the old site libraries.

b. For the rest of the old site libraries, such as OLDSITE.EC.SCNTL and 
OLDSITE.EC.SLG, you need to use ISPF 3.3, IEBCOPY, or 
IEBGENER in a batch job to copy the contents to the new site 
libraries.  (Depending on the data that is processed into your old site 
libraries, you might find that some of the libraries are empty.) 

� On an NT server host: 

a. Start with c:\oldsite\ec\data and c:\oldsite\ec\site.  These 
two libraries contain SAS objects such as catalogs, data sets, and 
views.  The SAS COPY procedure is used to convert the SAS objects 
from Version 6 to Version 8. 

Invoke SAS Version 8 on the server host and type the following 
statements in the Program Editor window.  Edit the location of 
your ITCM site library and submit the edited code for the two 
libraries, respectively.
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For example, if c:\oldsite\ec\site is your ITCM site 
library, the edited statements should be

LIBNAME oldlib 'c:\oldsite\ec\site' ACCESS=READONLY;

LIBNAME newlib 'c:\newsite\ec\site';

PROC COPY IN=oldlib OUT=newlib;

RUN;

If you check the ITCM 2.3 site libraries at this point, you should 
see SAS Version 8 objects such as catalogs, data sets, and views 
that have been converted from the corresponding SAS Version 
6 objects in the old site libraries.

b. For the rest of the old site libraries, such as c:\oldsite\ec\scntl 
and c:\oldsite\ec\slg, you need to use either the MS-DOS 
command or Windows Explorer to copy the contents to the new site 
libraries.  (Depending on the data that is processed into your old site 
libraries, you might find that some of the libraries are empty.)

For example, if c:\oldsite\ec\scntl is the site library, the 
MS-DOS command for copying the contents of the old site 
library to the new site library is

COPY c:\oldsite\ec\scntl\*.* c:\newsite\ec\scntl

Your PDBs
In the Preparation section earlier, you successfully migrated your PDBs from SAS Version 6 to SAS 
Version 8.  If you check the contents of the new Version 8 PDB, you should see nine standard ITSV 
libraries (e.g., detail, day, and so on) in the new PDB library.  If in doubt, check with your site's IT 
Service Vision administrator or the person who migrated the IT Service Vision environment from 
SAS Version 6 to SAS Version 8.

The following steps describe how to migrate the PDB contents that are ITCM specific from the 
Version 6 PDB to the new Version 8 PDB.  

1. Allocate space for storing the ITCM PDB libraries in the new Version 8 PDB. 

� On an OS/390 server host: 

Run IEFBR14 or use ISPF 3.2 to allocate space for the ITCM PDB 
libraries.  For allocation you can use the same DCB= as the one for the 
ITCM 2.0 library.  If your Version 8 PDB is located at NEWPDB, allocate 
space for  

� NEWPDB.EC.CNTL 



Migrating Your IT Charge Manager Environment from SAS Version 6 to SAS Version 8 Page 7 of 12

� NEWPDB.EC.PDB 
� NEWPDB.EC.SUSP 
� NEWPDB.EC.WORK 

� On an NT server host: 

If your Version 8 PDB is located at c:\newpdb, create the following 
directories:

� c:\newpdb\ec

� c:\newpdb\ec\cntl

� c:\newpdb\ec\pdb

� c:\newpdb\ec\susp

� c:\newpdb\ec\work 

2. Copy the contents of the Version 6 PDB libraries to the Version 8 PDB. 

� On an OS/390 server host: 

a. In your Version 6 PDB, for example, OLDPDB, you should have three 
libraries, OLDPDB.EC.PDB, OLDPDB.EC.SUSP, and 
OLDPDB.EC.WORK.  These libraries contain SAS objects such as 
catalogs, data sets, and views.  You will need to run the SAS COPY 
procedure to convert the SAS objects from Version 6 to Version 8.  
(Depending on the data that is processed into your old PDB libraries, 
you might find that some of the libraries are empty.) 

Invoke SAS Version 8 on the server host and type the following 
statements in the Program Editor window.  Edit the locations of 
your PDB libraries and submit the edited code for the three 
libraries, respectively.

LIBNAME oldpdbec 'location-of-your-ITCM 2.0-PDB-library'

DISP=SHR;

LIBNAME newpdbec 'location-of-your-ITCM 2.3-PDB-library';

PROC COPY IN=oldpdbec OUT=newpdbec;

RUN;

If OLDPDB.EC.PDB is your old PDB library, the edited 
statements should be

LIBNAME oldpdbec 'OLDPDB.EC.PDB' DISP=SHR;

LIBNAME newpdbec 'NEWPDB.EC.PDB';

PROC COPY IN=oldpdbec OUT=newpdbec;

RUN;
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If you check the Version 8 PDB libraries at this point, you 
should see SAS Version 8 objects such as catalogs, data sets, 
and views that have been converted from the corresponding 
SAS Version 6 objects in the old PDB libraries.

b. For the rest of the libraries, such as OLDPDB.EC.CNTL, 
OLDPDB.EC.PLG, and OLDPDB.EC.SEQ, you need to use ISPF 3.3, 
IEBCOPY, or IEBGENER in a batch job to copy the contents to their 
corresponding libraries in the NEWPDB.  For example, use ISPF3.3 
to copy OLDPDB.EC.CNTL to NEWPDB.EC.CNTL. 

� On an NT server host: 

a. In your Version 6 PDB, for example, c:\oldpdb, you should have 
three libraries, c:\oldpdb\ec\pdb, c:\oldpdb\ec\susp, and 
c:\oldpdb\ec\work.  These libraries contain SAS objects such as 
catalogs, data sets, and views.  You will need to run the SAS COPY 
procedure to convert the SAS objects from Version 6 to Version 8.  
(Depending on the data that is processed into your old PDB libraries, 
you might find that some of the libraries are empty.) 

Invoke SAS Version 8 on the server host and type the following 
statements in the Program Editor window.  Edit the locations of 
your PDB libraries and submit the edited code for the three 
libraries, respectively.

LIBNAME oldpdbec 'location-of-your-ITCM 2.0-PDB-library'

ACCESS=READONLY;

LIBNAME newpdbec 'location-of-your-ITCM 2.3-PDB-library';

PROC COPY IN=oldpdbec OUT=newpdbec;

RUN;

If c:\oldpdb\ec\pdb is your old PDB library, the edited 
statements should be

LIBNAME oldpdbec 'c:\oldpdb\ec\pdb' ACCESS=READONLY;

LIBNAME newpdbec 'c:\newpdb\ec\pdb';

PROC COPY IN=oldpdbec OUT=newpdbec;

RUN;

If you check the Version 8 PDB libraries at this point, you 
should see SAS Version 8 objects such as catalogs, data sets, 
and views that have been converted from the corresponding 
SAS Version 6 objects in the old PDB libraries.
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b. For the rest of the libraries, such as c:\oldpdb\ec\cntl, 
c:\oldpdb\ec\plg, and c:\oldpdb\ec\seq.sas, you need to use 
either the MS-DOS command or Windows Explorer to copy the 
contents to the new PDB libraries. 

For example, if c:\oldpdb\ec\cntl is the PDB library, then 
the MS-DOS command for copying the contents of the Version 
6 PDB library to the new PDB library is

COPY c:\oldpdb\ec\cntl\*.* c:\newpdb\ec\cntl

Your Account View Extract File
You can skip this section if you do not have the Account View extract file of ITCM 2.0.

The following instructions tell you how to migrate your Account View extract file from ITCM 2.0 to 
ITCM 2.3:

1. Find the location of the Account View extract file that you downloaded from ITCM 2.0. 
2. Choose a location on your computer where you want to store the ITCM 2.3 Account View 

extract file that is being migrated from ITCM 2.0. 
3. Convert the Account View extract file from ITCM 2.0 to ITCM 2.3.  

Invoke SAS Version 8 of Windows and type the following statements in the Program 
Editor window.  Edit the directories where your Account View extract files are located 
and submit the edited code.

LIBNAME oldav 'directory-where-your-ITCM 2.0 Account
View-extract-file-is-located'
ACCESS=READONLY;

LIBNAME newav 'directory-where-your-ITCM 2.3 Account
View-extract-file-is-located';

PROC COPY IN=oldav OUT=newav;

RUN;

Launch IT Charge Manager Software, Release 2.3
1. Before you invoke ITCM 2.3, you need to replace the default site definition provided by ITCM 

2.3 with your own site definitions.  The default site definition is found at 
drive:\[SAS Version 8 Install Path]\cpe\chm\ec\ecsite\ec_sites.sas7bdat.
Obtain the directory name of the backup ec_sites data set that you made in the Preparation 
section.  Invoke SAS Version 8 on Windows. Then type the statements below in the Program 
Editor window, edit them, and submit the edited code. 

LIBNAME olddef 'directory-which contains-the-backup-ec_sites-table'



Migrating Your IT Charge Manager Environment from SAS Version 6 to SAS Version 8 Page 10 of 12

ACCESS=READONLY;

LIBNAME newdef 'drive:\[SAS Version 8 Install Path]\cpe\chm\ec\ecsite';

PROC COPY IN=olddef OUT=newdef;

SELECT EC_SITES;

RUN;

2. Invoke IT Charge Manager Release 2.3 for SAS Version 8.  You should see your site 
definitions of ITCM 2.0 displayed in the Welcome to IT Charge Manager window. 

3. Select a site and modify the text fields, such as IT Charge Manager Site Prefix, displayed in the 
Site Properties box.  Check with your ITSV administrator if you need assistance with the 
following modifications. 

� Change the IT Charge Manager Site Prefix to refer to the same site prefix that you 
decided earlier at step 2 in the section Your Site Libraries for IT Charge Manager. 

� Modify the IT Service Vision SITELIB to reflect the SAS Version 8 ITSV site 
library. 

� Verify that the logon script file is valid for invoking SAS Version 8 on the server. 
� If your site resides in a local Windows environment, you need to change the 

CPUSEROPT data set to the one for SAS Version 8 ITSV. 

4. Click the Save Properties button to save the information in the Site Properties box. 
5. Click Open to open the site. 
6. If the site is located on an OS/390 server host, select the Site Administration tab and click 

Manage Site Defaults and Accounting Calendar.  Click Execution Control on the right.  
Modify the JCL parameters to correctly reflect the settings for your SAS Version 8 system.  
Click OK to save the modifications. 

7. Under the Site Administration tab, click Manage Site Defaults and Accounting Calendar.  
Click Calendar Definitions on the right.  Verify the calendar definitions for this site and click 
OK.  This will update the definitions and upload them to the server.  This step is required to 
ensure the correct regeneration of the calendar definitions through ITCM 2.3. 

8. Choose a PDB by clicking the PDB selection button in the upper-left corner.  Select the 
Manage PDBs tab.  Select Define Rate Models, Charges, and Assignments. 

9. If your site is located on an OS/390 server host, click Execution Control on the right.  Verify 
the JCL statements and click OK. 

10. Click Data Base Definition on the right. 
11. Select the item called Apply Selections and Edit, Manual Submit.  Click OK.  The Edit and 

Submit CPDDUTL Batch Job window should open. 
12. Verify the code of the batch job and make any necessary modifications. 
13. Click the Submit pull-down menu and select Save, Submit, and End to run the Data Base 

Definition job (CPDDUTL), which updates the dictionary. 

For OS/390 server, you must disconnect from the site in ITCM 2.3 in order for the Data 
Base Definition job to finish running.  ITCM 2.3 automatically detects this and presents a 
window to facilitate the disconnection as soon as you submit the job.

14. To ensure that your batch jobs refer to the appropriate data sets in your new PDB and site 
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libraries after the migration, regenerate the batch job code through the ITCM 2.3 graphical user 
interface. 

� For Consolidation 

a. Select the Operation tab in the ITCM 2.3 main window.  Select 
Consolidate Data. 

b. Select an invoice period and click Apply Selections and Edit, 
Manual Submit.  Click OK.  The Edit and Submit CONSOL Batch 
Job window should open. 

c. Verify the code of the batch job and make any necessary 
modifications. 

d. Save the batch job.  If appropriate, submit the job via the Submit pull-
down menu at this time. 

e. Repeat steps a through d for other invoice periods. 

� For To-Date Consolidation 

a. Select the Reports tab in the ITCM 2.3 main window.  Select To-
Date Consolidation. 

b. Select an invoice period and click Apply Selections and Edit, 
Manual Submit.  Click OK.  The Edit and Submit CONSOLz Batch 
Job window should open. 

c. Verify the code of the batch job and make any necessary 
modifications. 

d. Save the batch job.  If appropriate, submit the job via the Submit pull-
down menu at this time. 

e. Repeat steps a through d for other invoice periods. 

� For Standard Invoices 

a. Select the Operation tab in the ITCM 2.3 main window.  Select Run 
Standard Invoices. 

b. Select an invoice period and click Apply Selections and Edit, 
Manual Submit.  Click OK.  The Edit and Submit SCHRPT Batch 
Job window should open. 

c. Verify the code of the batch job and make any necessary 
modifications. 

d. Save the batch job.  If appropriate, submit the job via the Submit pull-
down menu at this time. 

e. Repeat steps a through d for other invoice periods. 

� For To-Date Reporting 

a. Select the Reports tab in the ITCM 2.3 main window.  Select To-
Date Reporting. 

b. Select an invoice period and click Apply Selections and Edit, 
Manual Submit.  Click OK.  The Edit and Submit todate Batch Job 
window should open. 
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c. Verify the code of the batch job and make any necessary 
modifications. 

d. Save the batch job.  If appropriate, submit the job via the Submit pull-
down menu at this time. 

e. Repeat steps a through d for other invoice periods. 

� For Site Configuration 

a. Select the Reports tab in the ITCM 2.3 main window.  Select Site 
Configuration. 

b. Click Apply Selections and Edit, Manual Submit.  Click OK.  The 
Edit and Submit conrpt Batch Job window should open. 

c. Verify the code of the batch job and make any necessary 
modifications. 

d. Save the batch job.  If appropriate, submit the job via the Submit pull-
down menu at this time. 

15. Repeat steps 5 through 14 for each PDB of the selected site. 


